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technology may not be used for or incorporated into any products or systems whose manufacture, use, or sale is prohibited 
under any applicable domestic or foreign laws or regulations. 

6. Renesas Electronics has used reasonable care in preparing the information included in this document, but Renesas Electronics 
does not warrant that such information is error free.  Renesas Electronics assumes no liability whatsoever for any damages 
incurred by you resulting from errors in or omissions from the information included herein. 

7. Renesas Electronics products are classified according to the following three quality grades:  “Standard”, “High Quality”, and 
“Specific”.  The recommended applications for each Renesas Electronics product depends on the product’s quality grade, as 
indicated below.  You must check the quality grade of each Renesas Electronics product before using it in a particular 
application.  You may not use any Renesas Electronics product for any application categorized as “Specific” without the prior 
written consent of Renesas Electronics.  Further, you may not use any Renesas Electronics product for any application for 
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liable for any damages or losses incurred by you or third parties arising from the use of any Renesas Electronics product for an 
application categorized as “Specific” or for which the product is not intended where you have failed to obtain the prior written 
consent of Renesas Electronics.  The quality grade of each Renesas Electronics product is “Standard” unless otherwise 
expressly specified in a Renesas Electronics data sheets or data books, etc. 

“Standard”: Computers; office equipment; communications equipment; test and measurement equipment; audio and visual 
equipment; home electronic appliances; machine tools; personal electronic equipment; and industrial robots. 

“High Quality”: Transportation equipment (automobiles, trains, ships, etc.); traffic control systems; anti-disaster systems; anti-
crime systems; safety equipment; and medical equipment not specifically designed for life support. 
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・ The information in this document is current as of date of its publication. The information is subject to 
change without notice. For actual design-in, refer to the latest publications of NEC Electronics data 
sheets or data books, etc., for the most up-to-date specifications of NEC Electronics products. Not all 
products and/or types are available in every country. Please check with an NEC sales representative 
for availability and additional information. 

 
・ No part of this document may be copied or reproduced in any form or by any means without prior 

written consent of NEC Electronics.  NEC Electronics assumes no responsibility for any errors that 
may appear in this document. 

 
・ NEC Electronics does not assume any liability for infringement of patents, copyrights or other 

intellectual property rights of third parties by or arising from the use of NEC Electronics products listed 
in this document or any other liability arising from the use of such NEC Electronics products.  No 
license, express, implied or otherwise, is granted under any patents, copyrights or other intellectual 
property rights of NEC Electronics or others. 

 
・ Descriptions of circuits, software and other related information in this document are provided for 

illustrative purposes in semiconductor product operation and application examples.  The incorporation 
of these circuits, software and information in the design of customer's equipment shall be done under 
the full responsibility of customer.  NEC Electronics no responsibility for any losses incurred by 
customers or third parties arising from the use of these circuits, software and information.  

 
・ While NEC Electronics endeavors to enhance the quality, reliability and safety of NEC Electronics 

products, customers agree and acknowledge that the possibility of defects thereof cannot be 
eliminated entirely.  To minimize risks of damage to property or injury (including death) to persons 
arising from defects in NEC Electronics products, customers must incorporate sufficient safety 
measures in their design, such as redundancy, fire-containment and anti-failure features. 

 
・ NEC Electronics products are classified into the following three quality grades: “Standard”, “Special” 

and “Specific”. 
 

The "Specific" quality grade applies only to NEC Electronics products developed based on a customer-
designated “quality assurance program” for a specific application.  The recommended applications of NEC 
Electronics product depend on its quality grade, as indicated below.  Customers must check the quality 
grade of each NEC Electronics product before using it in a particular application. 
 
"Standard": Computers, office equipment, communications equipment, test and measurement 
  equipment, audio and visual equipment, home electronic appliances, machine tools, 
  personal electronic equipment and industrial robots. 
 
"Special":  Transportation equipment (automobiles, trains, ships, etc.), traffic control systems, anti- 
   disaster systems, anti-crime systems, safety equipment and medical equipment (not 
   specifically designed for life support). 
 
"Specific":  Aircraft, aerospace equipment, submersible repeaters, nuclear reactor control systems,  
   life support systems and medical equipment for life support, etc. 
 
The quality grade of NEC Electronics products is “Standard” unless otherwise expressly specified in NEC 
Electronics data sheets or data books, etc. If customers wish to use NEC Electronics products in 
applications not intended by NEC Electronics, they must contact NEC Electronics sales representative in 
advance to determine NEC Electronics 's willingness to support a given application. 
 
Notes:  1." NEC Electronics" as used in this statement means NEC Electronics Corporation and also 
    includes its majority-owned subsidiaries. 

 2. " NEC Electronics products" means any product developed or manufactured by or for NEC 
  Electronics (as defined above). 
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CAUTION 
 

This is a Test- and Measurement equipment with possibility to be significantly 
altered by user through hardware enhancements/modifications and/or test or 
application software. Thus, with respect to Council Directive 89/336/EEC 
(Directive on compliance with the EMC protection requirements), this 
equipment has no autonomous function. Consequently this equipment is not 
marked by the CE-symbol. 

EEDT-ST-0005-10 
 

 
 

 
Redemption of Waste Electrical and Electronic Equipment 
(WEEE) in accordance with legal regulations applicable in the 
European Union only: This equipment (including all 
accessories) is not intended for household use. After use the 
equipment cannot be disposed of as household waste. NEC 
Electronics (Europe) GmbH offers to take back the equipment. 
All you need to do is register at www.eu.necel.com/weee. 
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1. Introduction 
L_Line - See it! is a demonstration kit for the NEC’s L_Line 8-Bit microcontroller family with integrated 
LCD controller. It supports onboard FLASH programming and real time execution of application 
programs up to 4 kBytes of program code. The board is prepared to be connected to user hardware parts 
such as digital I/O or analogue signals. 

1.1 Main features of L_Line – See it! 

• Easy to use device demonstration capabilities 
L_Line - See it! contains elements to easily demonstrate simple I/O-functions, i.e. navigator switch, 
112 segment LCD panel, phototransistor, temperature sensor, I/O lines, UART serial interface etc. 

 
• On-Board debug function 

The K_Line – Lin it! supports an On-Board debug function by using the IAR C-SPY debugger. It 
Allows FLASH downloading and standard debug functions i.e. code execution, single stepping, 
breakpoints, memory manipulation etc. 

 
• Flexible power supply 

The K_Line – Lin it! supports a flexible configuration of it’s power supply. The board can be powered 
by the USB interface, the QB-78K0MINI On-Chip debug emulator as well by an external CR2032 3V 
lithium coin battery. 

 
• LCD panel 

L_Line - See it! provides a 112 segment standard LCD panel, allowing the implementation of 
human / machine interface, comfortable input / output functions, output of measurement values, 
output of status information etc.  
 

• FPL3, FLASH programming software 
A windows based FLASH programming software allows to select and download application programs 
to the L_Line - See it! board for evaluation purposes. 

 
• Analogue to digital signal conversion is supported 

 
• Various input / output signals available, such as 
 

° All I/O ports prepared to be connected to user hardware 
° 112 segment standard LCD panel, 8 digits a 14 segments each 
° Timer input / output signals 
° Two or three wire serial I/O 
° UART interface, via USB UART chip FT232 
° 8 analogue input lines 
° Temperature sensor KTY13-5 
° Phototransistor PT15-21C 
° Navigation switch prepared for key interrupt generation 
 

• The IAR Embedded Workbench for 78K0/78K0S and the IAR C-SPY debugger / simulator are 
included. These packages are restricted in such that maximum program code size is limited to  
4 kByte of program code. 

 
•  Full documentation is included for the NEC 78K0/LG2 microcontroller, IAR Systems Embedded 

Workbench, IAR Systems C-SPY debugger / simulator and the NEC FPL3 FLASH programming 
software. 

 
L_Line - See it! is not intended for code development. NEC does not allow and does not support 
in any way any attempt to use L_Line - See it! in a commercial or technical product. 
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1.2 System requirements 

 
HOST PC A PC supporting Windows 98SE, Windows ME, Windows 2000 or 

Windows XP is required for the IAR Systems Embedded Workbench 
demo-version and the FPL3 FLASH programming software. 
Pentium 166 MHz (at least), 128 MB of RAM, 256-color display (1024 * 
768), mouse, CD-ROM drive and 200 Mbytes of free hard disk space are 
required to install the tool packages. 
 
Above listed requirements are valid for the IAR Systems Embedded 
Workbench and the FPL3 FLASH programming software. 
 

Host interface USB interface that enables communication based on USB (Ver1.1 or 
later) 
 

1.3 Package contents 

Please verify that you have received all parts listed in the package contents list attached to the  
L_Line - See it! package. If any part is missing or seems to be damaged, please contact the dealer from 
whom you received your L_Line - See it!. 
 
Note: Updates of the IAR Embedded Workbench for 78K, FP3 FLASH programming software, 

documentation and/or utilities for L_Line - See it!, if available, may be downloaded from the 
NEC WEB page(s) at http://www.eu.necel.com/updates 

 
 

1.4 Trademarks 

IAR Embedded Workbench, visualSTATE, IAR MakeApp and C-SPY are registered trademarks of IAR 
Systems AB. Microsoft and Windows are registered trademarks of Microsoft Corporation. Adobe and 
Acrobat Reader are registered trademarks of Adobe Systems Incorporated.  
 
All other product names are trademarks or registered trademarks of their respective owners. 
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2. L_Line - See it! system configuration 
 
The L_Line - See it! system configuration is given in the diagram below: 
 

 
 

Figure 1: L_Line - See it! system configuration 

2.1 L_Line - See it! 

L_Line – See it! is a demonstration kit for the 78K0/LG2 8-Bit microcontroller with integrated LCD 
controller. The L_Line – See it! board is connected to the host system via USB interface cable. The host 
system may be used for onboard FLASH programming of the 78K0/LG2 internal FLASH memory and to 
allow execution of application programs on L_Line – See it! starterkit. Additionally it supports On-Chip 
debug functionality by using the IAR C-SPY debugger. 
 
L_Line - See it! runs the microcontroller at 6.0000 MHz operating speed. Sub-clock is provided with 
32.768 kHz. 
 

2.2 Host computer 

The USB host interface enables communication to the L_Line - See it! board. The USB UART chip 
FT232 allows application software to access the USB device in the same way as it would access a 
standard RS232 interface. The FTDI's Virtual COM Port ( VCP ) driver appears to the windows system 
as an extra Com Port, in addition to any existing hardware Com Ports.  
 

2.3 Power supply via USB interface 
The L_Line - See it! supports a flexible configuration of it’s power supply. The board can be powered 
by the USB interface, the QB-78K0MINI On-Chip debug emulator as well by an external CR2032 3V 
lithium coin battery (not assembled). 
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3. L_Line - See it! components 
 
The L_Line - See it! board is equipped with a navigation switch, a 112 segment LCD panel, temperature / 
light sensor and with several connectors in order to be connected to host computers, FLASH 
programmer or any external target hardware. 
 

 
Figure 2: L_Line - See it! board connectors and switches, top view 
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    Figure 3: L_Line - See it! board connectors and switches, button view 

 
Some of the L_Line – See it! components are free for user application hardware and software. Please 
read the user’s manual of the 78K0/LG2 device carefully to get information about the electrical 
specification of the available I/O ports before you connect any external signals to the L_Line – See it! 
board. 
 

 

CN2 

BAT1 
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3.1 Power supply selection, Jumper JP1 

The different power supply modes of the L_Line - See it! board can be set by jumper JP1. Jumper JP1 
controls the power supply during the stand-alone, FLASH programming and On-Board debugging mode. 
Additionally power supply can be applied by the QB-78K0MINI On-Chip debug emulator, controller by 
jumper JP2. 
 

JP1 Jumper Setting Mode 
1-2 Closed (default)  Power supply via USB 

interface, CN7 
2-3 Closed Power supply via battery, 

BAT1 

Table 1: Power supply selection, Jumper JP1 

 

3.2 OCD power supply, Jumper JP2 
The power supply of the L_Line - See it! board can also be applied by the QB-78K0MINI On-Chip debug 
emulator. Close jumper JP2 to apply power from the QB-78K0MINI. 
 

JP2 Jumper Setting Mode 
Open (default)  Power supply via USB or 

Battery 
1-2 

 
Closed Power supply via 

QB-78K0MINI emulator 

Table 2: OCD power supply, Jumper JP2 

 

3.3 Clock supply, Jumper JP3 

The clock supply of the 78K0/LG2 device is controlled by jumper JP3. By closing JP3 external frequency 
of 6 MHz is applied to the P122/X2 clock input pin of the 78K0/LG2 device. When opening JP3 an 
external oscillator can be used. To use this mode equip pad X1 (not assembled) of the L_Line – See it! 
board with an corresponding oscillator. 
 

JP3 Jumper Setting Mode 
1-2 

 
Closed (default)  Clock frequency = 6 MHz, 

supplied by CPLD 
 Open •  Clock supply by external 

oscillator. By using this 
mode be sure to equip a 
crystal oscillator to the X1 
pad. 

•  For using the QB-78K0MINI 
On-Chip debug emulator 

Table 3: Clock supply, Jumper JP3 
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3.4 Configuration switch SW1 

The different operation modes of the L_Line - See it! board can be set by SW1 switches S1-S4.  
 

SW1 Factory settings Mode 
S1 OFF Normal operation mode 
S2 OFF UART6 select 
S3 OFF OCD disabled 
S4 OFF On-Board debug function 

Table 4: Configuration switch SW1, factory settings 

 

3.4.1 Operation mode selection, SW1/S1 

SW1 switch S1 controls the operation mode of the L_Line - See it! board. Setting SW1/S1 to ON allows 
to reprogram the internal FLASH memory of the 78K0/LG2 device by using the FPL3 FLASH 
programming software. 
 
 

SW1, S1 Mode 
OFF (default) Normal operation mode 
ON FLASH memory programming mode 

Table 5: Operation mode selection SW1/S1 

 
Within the normal operation mode the user program stored in the FLASH memory of 78K0/LG2 is 
executed. 
 

3.4.2 UART selection, SW1/S2 
SW1 switch S2 specifies the corresponding UART signals of the 78K0/LG2 device that are connected to 
the FT232 interface lines. 
 
 

SW1, S2 Mode 
OFF (default) UART6 select 
ON UART0 select 

Table 6: UART selection SW1/S2 

 

3.4.3 On-Chip debug enable, SW1/S3 

SW1 switch S3 controls the On-Chip debugging for the 78K0/LG2 device. Setting switch S3 to ON allows 
to use the On-Board debug function of the L_Line – See it! board and additionally the connection of the 
QB-78K0MINI On-Chip debug emulator. 
 

 

 

Table 7: On-Chip debug enable SW1/S3 

 

SW1, S3 On-Chip debug 
OFF (default) Disabled 
ON Enabled 
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3.4.4 On-Chip debug mode select, SW1/S4 

SW1 switch S4 controls the On-Chip debug mode of L_Line - See it! board. Switching SW1/S4 to OFF 
allows to use the On-Board debug function of L_Line – See it! board. By using this mode no additional 
debug hardware like the QB78K0MINI On-Chip debug emulator is needed. The debugging is done via 
the default USB/UART connection to the Host computer. All standard debug function are available in the 
On-Board debug mode like FLASH programming / downloading, code execution, single stepping, 
breakpoints, memory manipulation etc. 
 
Setting switch SW1/S4 to ON allows connecting the QB-78K0MINI On-Chip debug emulator to the 
L_Line – See it! board in order to use On-Chip debug function of the 78K0/LG2 device. The QB-
78K0MINI is a separate product from NEC and it is not included in this starterkit package 
 
 

SW1, S4 OCD mode 
OFF (default) On-Board debug function 
ON QB-78K0MINI 

Table 8: On-Chip debug mode select SW1/S4 

 

3.5 RESET button, SW2 

SW2 is the reset button. It activates the power on reset. It is connected to the reset input of the 
78K0/LG2 microcontroller. 
 
Note:  By supplying power to the L_Line – See it! board via the battery the RESET button becomes 

inactive. Please use jumper JP1 to power OFF/ON the microcontroller. 
 

3.6 Navigation switch, SW3 

Button SW3 is a navigation switch connected to the key interrupt port of the 78K0/LG2 device. It 
operates in five directions including a center push function. The connection of SW3 is shown in the table 
below: 
 

 
Table 9: Navigation switch SW3 

 
 
 
 
 

SW3 Connection to the 
78K0/LG2 device 

Left P73/KR3 
Down P71/KR1 
Select P74/KR4 
Right P72/KR2 
Up P70/KR0 

Down (KR1)

Up (KR0)

Right 
(KR2)

Left 
(KR3)

Select
(KR4)

Down (KR1)

Up (KR0)

Right 
(KR2)

Left 
(KR3)

Select
(KR4)
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3.7 Soldering bridges SB1, SB3, SB4, SB5 and SB6 

Additional configuration of the L_Line – See it! board can be done by the soldering bridges SB1, SB3, 
SB4, SB5 and SB6. The different configuration modes are shown in the table below: 
 
 

 
Figure 4: Soldering bridges SB1, SB3-SB6 

 

Table 10: Setting of soldering bridges SB1, SB3-SB6 

 
By cutting the default connections (pad 1-2) of soldering bridges SB3/SB4 respectively SB5/SB6 and 
closing pads 2-3, the corresponding microcontroller signals are connected to the external connectors 
CN3 respectively CN5. In this mode the microcontroller pins can be used as standard I/O ports. Please 
configure the clock generator of the 78K0/LG2 device accordingly to use this mode. 
 
Note: Do not close the connection for the Clock Oscillator and external connectors at the same time. 

This can affect the operation of the Sub / Main clock oscillator negatively. 
 

Soldering 
bridge 

Pad Configuration Mode 

Closed (default) VCC connected to AVREF pin SB1 1-2 
Open VCC disconnected from AVREF pin 

1-2 
2-3 

Closed (default) 
Open   (default) 

Sub Clock Oscillator connected to P123/XT1 pin SB3 

1-2 
2-3 

Open 
Closed 

P123/XT1 pin connected to CN5-2 

1-2 
2-3 

Closed (default) 
Open   (default) 

Sub Clock Oscillator connected to P124/XT2 pin SB4 

1-2 
2-3 

Open 
Closed 

P124/XT2 pin connected to CN5-4 

1-2 
2-3 

Closed (default) 
Open   (default) 

Main Clock Oscillator connected to P121/X1 pin SB5 

1-2 
2-3 

Open 
Closed 

P121/X1 pin connected to CN3-38 

1-2 
2-3 

Closed (default) 
Open   (default) 

Main Clock Oscillator connected to P121/X2 pin SB6 

1-2 
2-3 

Open 
Closed 

P121/X2 pin connected to CN3-40 

 

SB3 
SB4 

SB5 
SB6 

SB1 

1 1 11  2  3 

1 1 11  2  3 

1 1 13  2  1 

1 1 13  2  1 
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3.8 USB interface connector CN7 

The CN7 connector allows connecting the FPL3 FLASH programming software to the L_Line - See it! 
board in order to program application software into the CPU internal flash. Additionally the On-Board 
debug function uses connector CN7 for communication with the host computer. The board power supply 
of 5V is also provided by connector CN7. 
 
For standard communication to a host system i.e. by using a terminal program the input/output signals of 
UART6 respectively UART0 of the 78K0/LG2 device are connected to CN7. 
 

1 5

 
Figure 5: Connector CN7, USB Mini-B Type Host Connector Pin Configuration 

 
 

USB Connector 
CN7 

Signal Name 

1 VBUS 
2 DM 
3 DP 
4 N.C. 
5 GNDBUS 

Table 11: Pin Configuration of USB Connector CN7 

 
For connection with the host machine, use a USB cable (Mini-B type). For confirmation, 
NEC Electronics used only the USB cable delivered with the L_Line - See it! board. 
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3.9 FLASH programmer connector CN2 

Connector CN2 (not assembled) allows connecting the PG-FP4 FLASH programmer to L_Line – See it! 
board in order to program application software into the CPU internal flash memory. Please note, the  
PG-FP4 FLASH programmer is a separate product from NEC and it is not included in this package. 
 
 

CN2 Signal 
1 GND 

2 RESET 

3 SI 

4 VCC 

5 SO 

6 N.C. 

7 SCK 

8 N.C. 

9 N.C. 

10 N.C. 

11 N.C. 

12 FLMD1 

13 N.C. 

14 FLMD0 

15 N.C. 

16 N.C. 

Table 12: CN4, PG-FP4 connector 

 
When using PG-FP4, the programming interface to the 78K0/LG2 device must be set to the clock serial 
interface, CSI-Ring-Osc. Please configure the L_Line – See it! board as following: 
 
 

SW1 Setting Mode 
S1 OFF Normal operation mode 
S2 OFF UART6 select 
S3 OFF OCD disabled 
S4 OFF On-Board debug function 

Jumper Setting Mode 
JP1 1-2 Closed Power supply via USB 
JP2 Open Power supply via USB 
JP3 Closed Clock supplied via CPLD 

Table 13: Hardware configuration when using PG-FP4 
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3.9.1 OCD connector CN8 

Connector CN8 (not assembled) allows connecting the QB-78K0MINI On-Chip debug emulator to the 
L_Line – See it! board in order to use On-Chip debug function of the 78K0/LG2 device. QB-78K0MINI is 
a separate product from NEC and it is not included in this starterkit package. 
 
 

CN8 Signal 
1 RESET_IN 
2 RESET_OUT 
3 FLMD0 
4 VDD_IN 
5 X2 
6 GND 
7 X1 
8 GND 
9 N.C. 
10 N.C. 

Table 14: OCD connector CN8 

 
To enable On-Chip debugging by using the QB-78K0MINI On-Chip debug emulator configure the 
L_Line – See it! board as following: 
 
 

SW1 Setting Mode 
S1 OFF Normal operation mode 
S2 OFF UART6 select 
S3 ON OCD enabled 
S4 ON QB-78K0MINI enabled 

Jumper Setting Mode 
JP1 1-2 Closed Power supply via USB 

Open Power supply via USB JP2 
Closed Power supply via QB-78K0MINI (*Note) 

JP3 Open Clock supplied via QB-78K0MINI  

Table 15: SW1 configuration for OCD 

 
For more details on how to configure L_Line – See it! in order to use On-Chip debugging please refer to 
CHAPTER 4, ON-CHIP DEBUGGING. 
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3.10 LCD1, 112 segment standard LCD panel 

The L_Line - See it! board is equipped with a 112 segment standard LCD panel. The LCD is a 
transflective model type operating at 5V supply voltage. It can operate at a four times multiplex rate. The 
display can be used within a temperature range of -20°C … +70°C. The typical driving frequency is equal 
to 32 Hz (max. 100 Hz) within the complete temperature range. The LCD pin assignments, connections 
and segment definition is shown in table / figure below: 
 
 
 

LCD panel  
 

LCD panel  
 

Pin COM1 COM2 COM3 COM4 

78K0/LG2 
device 

Pin COM1 COM2 COM3 COM4 

78K0/LG2 
device 

1 S1 1F 1E 1D S0 36 1H 1G 1L 1M S2 
2 1I 1J 1K 1N S1 35 1A 1B 1C P1 S3 
3 S2 2F 2E 2D S4 34 2H 2G 2L 2M S6 
4 2I 2J 2K 2N S5 33 2A 2B 2C P2 S7 
5 S3 3F 3E 3D S8 32 3H 3G 3L 3M S10 
6 3I 3J 3K 3N S9 31 3A 3B 3C P3 S11 
7 S4 4F 4E 4D S12 30 4H 4G 4L 4M S14 
8 4I 4J 4K 4N S13 29 4A 4B 4C P4 S15 
9 S5 5F 5E 5D S16 28 5H 5G 5L 5M S18 

10 5I 5J 5K 5N S17 27 5A 5B 5C P5 S19 
11 S6 6F 6E 6D S20 26 6H 6G 6L 6M S22 
12 6I 6J 6K 6N S21 25 6A 6B 6C P6 S23 
13 S7 7F 7E 7D S24 24 7H 7G 7L 7M S26 
14 7I 7J 7K 7N S25 23 7A 7B 7C P7 S27 
15 S8 8F 8E 8D S28 22 8H 8G 8L 8M S30 
16 8I 8J 8K 8N S29 21 8A 8B 8C P8 S31 
17 NC NC NC COM4 COM4 20 COM0 NC NC NC COM0 
18 NC NC  COM3 NC COM3 19 NC COM1 NC NC COM1 

Table 16: LCD pin assignments / connections 

 
 
 

 
Figure 6: LCD panel / segment definition 
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3.11 Temperature sensor 

For temperature measurement and primarily as an application example a silicon temperature sensor 
KTY13-5 is connected to the input port of the 16-Bit Timer/Event Counter 00, equal to port P00 of 
78K0/LG2 device. The temperature sensor has a resistor range of R25 min = 1950 Ω and R25 max = 1990 Ω 
at 25 degrees centigrade, with IOP = 1mA. The distribution of the temperature factor kT is shown in the 
table below: 
 

 
Table 17: Distribution of temperature factor kT 

 
The sensor resistance can be calculated as following:  RT =  kT * R25 =  ∫(TA) 

 
     Figure 7: Typical dependence of sensor resistance 

 

 
  1) Normalising point 
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The temperature at the sensor can be calculated from the change in the sensors resistance from the 
following equation, which approximates the characteristic curve: 
 
 

 
 
The temperature measurement is done by using the dual slope method. Using the dual slope method a 
resistor value can be converted into a digital counter value. To do this, the charging time of capacitor 
C18 will be measured with the 16-Bit Timer/Event Counter 00 of the microcontroller. The first charging 
slope will use a reference resistor (RREF = R6) and the second charging slope will use variable resistor 
(RVAR= R5 + RT) which should be determined. By the comparison of the two measured times and the 
known reference resistor RREF the variable resistor can be calculated. 
 
The 78K0/LX2 device family has the advantage of bit settable I/O ports and Schmitt-trigger inputs (e.g. 
timer input port TI000). The L_Line – See it! board uses the bit settable port P0 as a bidirectional port. 
 
At first, the complete port P0 is cleared and set to output mode. In this case the capacitor C18 is 
discharged via P00/TI000 and prepared for the first measurement. The resistor R7 is only used to limit 
the current during the discharging of the capacitor. Then port P02 is set to 1 and output. At this point also 
the 16-bit Timer/Event Counter 00 is started. The rest of the port P0 is set to input (high impedance). So 
the capacitor will be charged via the reference resistor R6. When the capacitor has reached the threshold 
level of the Schmitt-trigger input P00/TI000, the actual timer value is automatically captured and an 
internal interrupt is generated. Using this interrupt the capture value is read out. In the next step the 
capacitor C18 will be discharged again. The same procedure starts once more with port P03. This time 
the capacitor is charged via the unknown resistor RVAR of the temperature sensor and after the threshold 
is reached again the second timer value is read out. 
 
The unknown RVAR can be calculated from the two values obtained using the method described above 
and consequently the resistor value of the temperature sensor. Please refer to derivation on the following 
sides. 
 

α² - 4 x β + 4 x β x kT - α
T  = 25  + ° C

2 x β

-3α = 7,88 x 10  x K

β = 1,937 x 10  x K

kT = 

-1

-5 -2

RT

R25

with:

α² - 4 x β + 4 x β x kT - α
T  = 25  + ° C

2 x β

-3α = 7,88 x 10  x K

β = 1,937 x 10  x K

kT = 

-1

-5 -2

RT

R25

-3α = 7,88 x 10  x K

β = 1,937 x 10  x K

kT = 

-1

-5 -2

RT

R25

with:
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The threshold level of the Schmitt-trigger input does not have any influence on the accuracy of the 
measurement. As this will be a constant for both measurements. 
 

 
 

The capacitor C18 and the supply voltage VDD do not have any influence on the accuracy of the 
measurement. Only the absolute value of the reference resistor RREF has an influence, because these 
parameters will not change during one measurement. Using the RREF, tREF and tVAR values, the resistor 
RVAR can be calculated. 
 

RREF:  R6 = VCREF = VDD 1 - e 

tREF

RREF x C
-

RVAR:  R5 + RT = VCREF = VDD 1 - e 

tVAR

RVAR x C
-

VC = VCVAR = VCREF = const 

 

VDD 1 - e 

tREF

RREF x C
-

VDD 1 - e 

tVAR

RVAR x C
-

=

1 - e 

tREF

RREF x C
-

1 - e 

tVAR

RVAR x C
-

=

e 

tREF

RREF x C
-

e 

tVAR

RVAR x C
-

=

tREF

RREF x C
tVAR

RVAR x C
=

tREF

RREF

tVAR

RVAR
=

tREF
RREF   x

tVAR
RVAR =

VDD 1 - e 

tREF

RREF x C
-

VDD 1 - e 

tVAR

RVAR x C
-

=

1 - e 

tREF

RREF x C
-

1 - e 

tVAR

RVAR x C
-

=

e 

tREF

RREF x C
-

e 

tVAR

RVAR x C
-

=

tREF

RREF x C
tVAR

RVAR x C
=

tREF

RREF

tVAR

RVAR
=

tREF
RREF   x

tVAR
RVAR =
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The diagram of the dual slope circuit is shown in the figure below: 
 

 
     Figure 8: Diagram of dual slope circuit 

 
The calculation of the charging time of the capacitor can be done as following: 
 

 
 

R6

R5

R7

C18

S1
(RT)

P02

P03

P00 / TI000

78K0/LG2

RREF = R6
RVAR   = R5 + RT

RT = temperature sensor resistance

R6

R5

R7

C18

S1
(RT)

P02

P03

P00 / TI000

78K0/LG2

RREF = R6
RVAR   = R5 + RT

RT = temperature sensor resistance

 

VC = VDD 1 - e 

t
R x C

-

= 1 - e 

t
R x C

-

VDD

VC

=  e 
R x C

-

VDD

VC

t

1 -

R x C
t

VDD

VC
1 -=  ln

VDD

VC
1 -t  = - R x C x ln

-

VC = VDD 1 - e 

t
R x C

-

= 1 - e 

t
R x C

-

VDD

VC

=  e 
R x C

-

VDD

VC

t

1 -

R x C
t

VDD

VC
1 -=  ln

VDD

VC
1 -t  = - R x C x ln

-
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Example: 
 

VDD = 5 V; Vthreshold = VC = (0,4 … 0,7) VDD 
 

Typical: Vthreshold = 0,6 x VDD 
 

RREF = 10 kΩ; C = C18 = 220 nF 
 
 

 
 
 
 

3.12 Phototransistor, Q1 
For light incidence measurement and primarily as an application example a phototransistor PT15-21C is 
connected to the ANI0 analogue input, equal to port P20 of the 78K0/LG2 device. 
 

3.13 Buzzer, BUZ1 
To generate acoustic signals and sound waves a buzzer is connected to the timer output port of the 16-
Bit Timer/Event Counter 01, equal to port P06/TI011/TO01 of the 78K0/LG2 device. The AC buzzer 
operates in a voltage range of 2V…5V. 
 

3.14 Battery holder, BAT1 

To power the L_Line – See it! board via battery, please equip the battery holder BAT1 with a CR2032 3V 
lithium coin type battery. 
 
 
 

VDD

VC
1 -t  = - RREF x C x ln

1 - 0,6t  = - 10 kΩ x 220 nF x ln

t  =  2,0158 ms

VDD

VC
1 -t  = - RREF x C x ln

1 - 0,6t  = - 10 kΩ x 220 nF x ln

t  =  2,0158 ms
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3.15 External connector CN3, CN4 and CN5 

CN3, CN4 and CN5 are connectors for external user hardware. The microcontroller signals are 
connected to CN3, CN4 and CN5. The L_Line - See it! board provides also a wire wrap field area - 
connector CN3 - allowing the integration of additional application hardware. 
 
 

 
 
 

     (N.C. = Not Connected) 

     Table 18: CN3, CN4, and CN5 connection to 78K0/LG2 

CN3 Signal CN3 Signal  CN4 Signal CN4 Signal  CN5 Signal CN5 Signal 

1 VCC 2 P25/ANI5  1 VSS 2 P00/TI000  1 N.C. 2 P123/XT1 
3 VCC 4 P26/ANI6  3 VSS 4 P01/TI010/TO00  3 N.C. 4 P124/XT2 
5 VCC 6 P27/ANI7  5 VSS 6 P02/SO11  5 N.C. 6 N.C. 
7 VCC 8 P30/INTP1  7 VSS 8 P03/SI11  7 N.C. 8 N.C. 
9 VCC 10 P31/INTP2  9 VSS 10 P04/SCK11  9 N.C. 10 N.C. 
11 VCC 12 P32/INTP3  11 VSS 12 P05/TI001/SSI11  11 N.C. 12 N.C. 
13 VCC 14 P33/INTP4/TI51/TO51  13 VSS 14 P06/TI011/TO01  13 N.C. 14 N.C. 
15 VCC 16 P60/SCL0  15 VSS 16 P10/SCK10/TXD0  15 N.C. 16 N.C. 
17 VCC 18 P61/SDA0  17 VSS 18 P11/SI10/RXD0  17 N.C. 18 N.C. 
19 VCC 20 P70/KR0  19 VSS 20 P12/SO10  19 N.C. 20 N.C. 
21 VCC 22 P71/KR1  21 VSS 22 P13/TXD6  21 N.C. 22 N.C. 
23 VCC 24 P72/KR2  23 VSS 24 P14/RXD6  23 N.C. 24 N.C. 
25 VCC 26 P73/KR3  25 VSS 26 P15/TOH0  25 N.C. 26 N.C. 
27 VCC 28 P74/KR4  27 VSS 28 P16/TOH1/INTP5  27 N.C. 28 N.C. 
29 VCC 30 P75/KR5  29 VSS 30 P17/TI50/TO50  29 N.C. 30 N.C. 
31 VCC 32 P76/KR6  31 VSS 32 P20/ANI0  31 N.C. 32 N.C. 
33 VCC 34 P77/KR7  33 VSS 34 P21/ANI1  33 N.C. 34 N.C. 
35 VCC 36 P120/INTP0/EXLVI  35 VSS 36 P22/ANI2  35 N.C. 36 N.C. 
37 VCC 38 P121/X1  37 VSS 38 P23/ANI3  37 N.C. 38 N.C. 
39 VCC 40 P122/X2  39 VSS 40 P24/ANI4  39 N.C. 40 N.C. 
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3.16 78K0/LG2 memory map 
 
The memory layout of 78K0/LG2 device shown in the figure below. 
 

 
                                                              Figure 9: 78K0/LG2 memory map 

 
The L_Line – See it! does not reserve any resources of the 78K0/LG2 device, consequently all available 
memory of the device is free for application software. 
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4. On-Chip debugging 
The L_Line - See it! board offers two possibilities to use On-Chip debugging (OCD). The On-Board 
debug function of L_Line – See it! allows On-Chip debugging without a need of external debug hardware. 
Within this mode the default USB / UART connection to the Host computer is used as debug interface. 
All standard debug functions are available in the On-Board debugging mode like FLASH programming / 
downloading, code execution, single stepping, breakpoints, memory manipulation etc. 
 
Additionally L_Line – See it! supports the QB-78K0MINI On-Chip debug emulator in order to use On-Chip 
debug function of the 78K0/LG2 device. The system configuration for On-Chip debugging is shown in 
figure below. 
 

 
 

4.1 OCD via On-Board debug function 
To operate the L_Line - See it! board within the On-Board debug mode, configure switch SW1 and 
Jumpers JP1-JP3 as following: 
 
 

SW1 Setting Mode 
S1 OFF Normal operation mode 
S2 OFF UART6 select 
S3 ON OCD enabled 
S4 OFF On-Board debug function 

Jumper Setting Mode 
JP1 1-2 Closed Power supply via USB 
JP2 Open Power supply via USB 
JP3 Closed Clock supplied via CPLD 
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4.2 OCD via QB-78K0MINI emulator 

To operate the L_Line - See it! board together with the QB-78K0MINI On-Chip debug emulator, configure 
switch SW1 and Jumpers JP1-JP3 as following: 
 
 

SW1 Setting Mode 
S1 OFF Normal operation mode 
S2 OFF UART6 select 
S3 ON OCD enabled 
S4 ON QB-78K0MINI enabled 

Jumper Setting Mode 
JP1 1-2 Closed Power supply via USB 

Open Power supply via USB JP2 
Closed Power supply via QB-78K0MINI (*Note) 

JP3 Open Clock supplied via QB-78K0MINI  
 
 
Note:  By supplying power from the QB-78K0MINI do not connect external hardware to the 

L_Line - See it! board. Within this mode the L_Line - See it! board can operate without 
external power supply from USB or a battery. 
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5. L_Line - See it! installation and operation 

5.1 Getting started 
The windows based FPL3 FLASH programming software allows to select and download application 
programs to L_Line - See it! starterkit. As communication interface between PC host system and the 
L_Line - See it! board a USB interface line is needed. Before you can download and run a program, 
hardware and software must be installed properly. 
 

5.1.1 CD-ROM contents 
The CD-ROM shows following directory structure: 
 

 L_Line  – See it! (F:) CD-ROM ROOT 

  Acrobat - Acrobat Reader for 32Bit Windows OS 

  Device Files - Device Files for L_Line – See it! 

   DDF  … Device Description Files and 
 … SFR Description Files for IAR C-SPY 

   NEC  … Device Files for IAR C-SPY 

  Doc - Documentation 

  FPL3 - FPL3 FLASH programming software 

   Drivers  … USB driver 

   FPL3  … FPL3 setup directory 

   PRM  … PRM parameter files 

  IAR Embedded Workbench 78K0 - IAR Embedded Workbench for 78K0/78K0S 

  SampleProgram - Sample program for L_Line  – See it! 

 

Table 19: L_Line - See it! CD-ROM directory structure  
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6. Hardware installation 
After unpacking L_Line - See it!, connect the board to your host computer using the provided USB interface 
cable. When L_Line - See it! is connected, the USB driver needs to be installed on the host machine. 
Please refer to the following CHAPTER 7 SOFTWARE INSTALLATION. 
 

7. Software installation 
The L_Line - See it! package comes with several software demo packages: 
 
• IAR Systems Embedded Workbench for 78K0/78K0S, including C compiler, assembler, linker, librarian 

and IAR C-SPY debugger / simulator 
• Device Files for L_Line – See it! 
• FPL3 FLASH programming software 
• Sample program 
 
The IAR Systems Embedded Workbenches and the FPL3 FLASH programming GUI must be installed on 
your PC. For detailed installation hints, refer to the following chapters and to the corresponding 
documentation of the IAR Embedded Workbench. 
 

7.1 IAR Systems Embedded Workbench for 78K0/78K0S installation 

To install the IAR Systems Embedded Workbench for 78K0/K0S including C-SPY debugger / simulator, 
select the SETUP program in the directory \IAR Embedded Workbench 78K\ew78k\ of the CDROM. 
The setup dialogues will guide you through the installation process. 
 

7.2 Device file installation 
To install the device files for the L_Line – See it! in order to use the IAR C-SPY debugger, select the SETUP 
program in the directory \Device Files\ of the CDROM. The setup dialogues will guide you through the 
installation process. 
 

7.3 FPL3 FLASH programming GUI installation 
To install the FPL3 FLASH programming GUI select the SETUP program in the directory \FPL3\ of the 
CDROM. The setup dialogues will guide you through the installation process. 
 

7.4 Sample program installation 
To install the sample/demonstration program for the L_Line – See it! board select the SETUP program in the 
directory \SampleProgram\ of the CDROM. The setup dialogues will guide you through the installation 
process. 
 



L_Line - See it!  

33 

 

7.5 USB Driver Installation 

In order to use the L_Line - See it! board for On-Chip debugging or FLASH programming, the 
USB driver needs to be installed on the host machine. Install the driver according to the 
following procedure: 

 
Installation on Windows 98SE/Me .........  Page 33 
Installation on Windows 2000 ...............  Page 35 
Installation on Windows XP ...................  Page 41 

 

7.5.1 Installation on Windows 98SE/Me 
1. When the K_Line - See it! board is connected with the host machine, the board is 

recognized by Plug and Play, and the wizard for adding new hardware is started.  Click 
Next>. 

 

Figure 10:  Add New Hardware Wizard (Windows 98SE) 

 
 

 
2. The window below is displayed.  So, check that "Search for a suitable driver ..." is selected, 

then click Next>. 
 

Figure 11: Search Method (Windows 98SE) 

 
 

Click. 

Check that "Search for a 
suitable driver ..." is selected. 

Click. 
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3. Check the "Specify a location" check box only and enter "C:\Program 

Files\NECTools32\FPL3\DRIVER" in the address bar, then click Next>. 
 

Figure 12: Search Location Specification (Windows 98SE) 

 
 
 
 
 
 
 
 
備考  3.1ソフトウエアのインストール先のフォルダを変更した場合は， 

 
 

Remark If the installation destination folder is changed at the time of GUI software installation, 
enter "new-folder\DRIVER". 

 
 

4. The window below is displayed.  Click Next>. 
 

Figure 13: Checking Driver to Be Installed (Windows 98SE) 

 
 

 
 

<1> Check "Specify 
a location" only. 

<3>  Click. 

<2>  Enter "C:\Program Files\NECTools32\FPL3\DRIVER". 

Click. 
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5. When the window below is displayed, the installation of the USB driver is completed.  Click 

Finish.  The installation of the USB Serial Port driver is then automatically performed. 
 

Figure 14: Installation Completion (Windows 98SE) 

 
 

 
 

7.5.2 Installation on Windows 2000 
 

1. When the L_Line - See it! board is connected with the host machine, the board is 
recognized by Plug and Play, and the wizard for finding new hardware is started.  Click 
Next>. 

 

Figure 15: Found New Hardware Wizard 1 (Windows 2000) 

 

Click. 

Click. 
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2. The window below is displayed.  So, check that "Search for a suitable driver ..." is selected, 

then click Next>. 
 

Figure 16: Search Method 1 (Windows 2000) 

 
 
 

3. Check the "Specify a location" check box only, then click Next>. 
 

Figure 17: Driver File Location 1 (Windows 2000) 

 
 

Click. 

Check that "Search for a 
suitable driver ..." is 
selected. 

Click. 

Check that "Specify a 
location" only is checked. 
ed.hed. 
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4. Enter "C:\Program Files\NECTools32\FPL3\DRIVER" in the address bar, then click OK. 

 

Figure 18: Address Specification 1 (Windows 2000) 

 
 
 
 
 
 
 

Remark If the installation destination folder is changed at the time of GUI software installation, 
enter "new-folder\FPL3\DRIVER". 

 
 

5. Click Next>. 
 

Figure 19: Driver File Search 1 (Windows 2000) 

 
 

Enter "C:\Program Files\NECTools32\FPL3\DRIVER". 

Click. 

Click. 
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6. Click Finish to complete the installation of the USB driver. 

 

Figure 20: USB Driver Installation Completion 1 (Windows 2000) 

 
 
 

7. Proceed to the installation of the USB Serial Port driver.  Click Next>. 
 

Figure 21: Found New Hardware Wizard 2 (Windows 2000) 

 
 

Click. 

Click. 
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8. The window below is displayed.  So, check that "Search for a suitable driver ..." is selected, 
then click Next>. 

 

Figure 22: Search Method 2 (Windows 2000) 

 
 
 

9. Check the "Specify a location" check box only, then click Next>. 
 

Figure 23: Driver File Location 2 (Windows 2000) 

 
 

Click. 

Check that "Search for a 
suitable driver ..." is 
selected. 

Click. 

Check that "Specify a 
location" only is checked. 
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10. Enter "C:\Program Files\NECTools32\FPL3\DRIVER" in the address bar, then click OK. 

  

    Figure 24: Address Specification 2 (Windows 2000) 

               
  
 
 
 
 
 

Remark If the installation destination folder is changed at the time of GUI software installation, 
enter "new-folder\DRIVER". 

 
 

11. Click Next>. 
  

   Figure 25: Driver File Search 2 (Windows 2000) 

 
 

  
  
  

Enter "C:\Program Files\NECTools32\FPL3\DRIVER". 

Click. 

Click. 
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12. Click Finish to complete the installation of the USB driver. 

  

   Figure 26: USB Driver Installation Completion 2 (Windows 2000) 

                 
  
 

7.5.3 Installation on Windows XP 
 

1. When the L_Line - See it! board is connected with the host machine, the board is 
recognized by Plug and Play, and the wizard for finding new hardware is started.  Check 
that "Install from a list or specific ..." is selected, then click Next>. 

 

Figure 27: Found New Hardware Wizard 1 (Windows XP) 

 
 

 

Check that "Install from a list 
or specific ..." is selected. Click. 

Click. 
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2. Check that "Search for the best driver in these locations." is selected.  Check the "Include 

this location in the search:" check box and enter "C:\Program 
Files\NECTools32\FPL3\DRIVER" in the address bar, then click Next>. 

 

Figure 28: Search Location Specification 3 (Windows XP) 

 
 

 
 
 
 
 
 

3. As shown below, "has not passed Windows Logo testing to verify its compatibility with 
Windows XP." is displayed.  Click Continue Anyway. 

 

Figure 29: Windows XP Logo Testing 3 (Windows XP) 

 

<1> Check that "Search for the 
best driver in these locations." 
is selected. 

<2> Check "Include this 
location in the search:" 
only. 

Click. 

<4>  Click. <3>  Enter "C:\Program Files\NECTools32\FPL3\DRIVER". 
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4. When the window below is displayed, the installation of the USB driver is completed.  Click 

Finish. 
 

Figure 30: USB Driver Installation Completion 1 (Windows XP) 

 

 
 

5. Proceed to the installation of the USB Serial Port driver.  Click Next>. 
 

Figure 31: Found New Hardware Wizard 2 (Windows XP) 

 
 
 

Click. 

Check that "Install from a list 
or specific ..." is selected. Click. 
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6. Check that "Search for the best driver in these locations." is selected.  Check the "Include 
this location in the search:" check box and enter "C:\Program 
Files\NECTools32\FPL3\DRIVER", then click Next>. 

 

Figure 32: Search Location Specification 2 (Windows XP) 

 
 
 
 
 
 
 
 
 

7. As shown below, "has not passed Windows Logo testing to verify its compatibility with 
Windows XP." is displayed.  Click Continue Anyway. 

 

Figure 33: Windows XP Logo Testing 2 (Windows XP) 

 

 

<1> Check that "Search for the best 
driver in these locations." is 
selected. 

<2> Check "Include this location 
in the search:" only. 

<4>  Click. <3>  Enter "C:\Program Files\NECTools32\FPL3\DRIVER". 

Click. 



L_Line - See it!  

45 

 
8. When the window below is displayed, the installation of the USB driver is completed.  Click 

Finish. 
 

Figure 34: USB Serial Port2 Driver Installation Completion (Windows XP) 

 
 
 
 

 
 
 

Click. 
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7.6 Confirmation of USB Driver Installation 
 
After installing the two types of drivers, check that the drivers have been installed normally, 
according to the procedure below. When using the L_Line - See it! board in combination with 
FPL3 GUI, the information to be checked here is needed. 

 
 

By clicking the "Device Manager" tab, check that the drivers are installed normally. 
 

Figure 35: Device Manager 

 
 

For Windows 98SE/Me 
Caution  Do not select Update and Erase when communicating with the target 

device. 
 

For Windows 2000/XP 
Caution  Do not perform "Hardware Modification Scan" when communicating with the 

target device. 
 
 

Remark In the GUI port list box, the same communication port as COM? of USB Serial Port 
(COM?) needs to be selected. 

 
 If the drivers above are not displayed, or the mark "×" or "!" is prefixed, refer to 

CHAPTER 10 TROUBLESHOOTING. 
 

 

Check that "USB Serial Port 
(COM?)" is present. 

Check that "USB High Speed 
Serial Converter" is present. 
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7.7 Driver deinstallation 
 

The driver deinstallation program is installed on the host machine when the FPL3 software is 
installed. Use the procedure below for deinstall the USB driver. 

 
 

1. When using Windows XP, log on as the computer administrator. When using Windows 
2000, log on as the Administrator. 

 
2. Double-click in the order from "My Computer" to "(C:)" to "Program Files" to "NECTools32" 

to "FPL3" to "DRIVER".  "Ftdiunin.exe" is displayed.  Double-click "Ftdiunin.exe". 
  

     Figure 36: Driver Uninstallation 

 
 
 

3. Click Continue. 
 

Figure 37: Driver Uninstaller 

 

Double-click. 

Click. 
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4. Click Finish to complete driver uninstallation. 
 

    Figure 38: Completion of Driver Uninstallation 

 
 

Caution If the GUI software is uninstalled earlier, "Ftdiunin.exe" is also deleted.  At this time, 
delete "USB Serial Port (COM?)" and "USB High Speed Serial Converter" from Device 
Manager manually. 

 
 

Click. 



L_Line - See it!  

49 

 

8. FPL3 FLASH programming software 

8.1 Introduction 
 
The parameter file for the 78K0/LG2 device is installed automatically during installation of FPL3 
GUI, folder <FPL3 install-path>\PRM. Nevertheless, newest version of parameter file for the 
µPD78F0397D device can by download from the NEC Electronics Web site. 
 
Download the parameter file for the PG-FP4 from the following NEC Electronics Web site: 
 

http://www.eu.necel.com/updates 
 
Copy the parameter file downloaded from the NEC Electronics Web site into sub-directory 
<FPL3.EXE-install-path>\PRM created during GUI software setup (refer to CHAPTER 7 
SOFTWARE INSTALLATION).. 

 
 

8.2 Starting up the GUI Software 
 

  •  GUI software startup 
 Select FPL3.EXE from the start menu to start the FPL3 GUI software. 

 
 

 When the GUI software is started normally, the following screen appears. 
 

Figure 39: GUI Software Main Window 

 
 

Menu bar 

Toolbar 

Action log window 

Status bar 

Programmer 
parameter 
window 
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This window consists of the following items: 

   
Name Display Information 
Menu bar 
(displayed at the top) 

Displays menu items executable by the 
FPL3. 

Toolbar 
(displayed under the menu bar) 

Displays frequently used commands as 
icons. 

Action log window 
(displayed under the toolbar) 

Displays an FPL3 action log. 
 

Programmer parameter window 
(displayed to the right of the action log 
window) 

Displays programming parameter 
settings. 
 

Status bar Displays status. 
 
 

8.3 Toolbar 

 
The toolbar contains buttons for starting the important procedures of the FPL3. 

 

Figure 40: Toolbar Buttons 

 
[Device] → [Setup] button 

 
[File] → [Load] button 

 
[Device] → [Blank Check] button 

 
[Device] → [Erase] button 

 
[Device] → [Program] button 

 
[Device] → [Verify] button 

 
[Device] → [Autoprocedure(EPV)] button 
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8.4 Menu Bar 
 
Depending on the actual device status and device type, some menu items may be enabled or 
disabled. 

 
 

8.4.1 [File] menu 
Clicking the [File] menu displays the pull-down menu as shown below. 
This menu mainly contains commands related to file operation. 

 

       Figure 41: [File] Menu 

 
 

(1) [Load] command 
The [Load] command allows you to select a program file. 
The selected program file is programmed into the flash memory of the device by 
executing the [Program] command or [Autoprocedure(EPV)] command. 

 

Figure 42: HEX File Selection Window 

 
 

 The file selection window for program loading displays the most recently used directory to 
which a user program has been loaded.  After a user program is loaded, a checksum 
calculation is made and the result is displayed in the programmer parameter window. 

 [  Open  button] 
 Selects a user program as a program to be written to the target device. 

 
 [  Cancel  button] 
 Closes the window without selecting a program. 
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(2) [Quit] command 
 The [Quit] menu is the command for terminating the FPL3 GUI software.  Clicking  ×  on 

the right side of the task bar also terminates the FPL3 GUI software. 
 User settings are saved in the FPL3.ININote file, so that the GUI software starts up next time 

with the same settings. 
 

Note FPL3.INI is created in the Windows folder when Windows 98SE, Windows Me, or 
Windows XP is used. 

 When Windows 2000 is used, FPL3.INI is created in the Winnt folder. 
 
 

8.4.2 [Device] menu 
Clicking the [Device] menu displays the pull-down menu as shown below. 
This menu mainly contains commands for programming operations such as deletion, 
programming, and verification on the target device. 

 

Figure 43: [Device] Menu 

 
 

(1) [Blank Check] command 
The [Blank Check] command allows you to make a blank check on the target device 
connected to the FPL3.  If the flash memory of the target device is erased, a blank 
check is terminated normally.  If the flash memory is not completely erased, the 
indication "not blank" is provided.  Before starting programming, erase the flash 
memory of the target device. 

 
(2) [Erase] command 

The [Erase] command erases the flash memory of the target device connected to the 
FPL3.  While the flash memory is being erased, the progress status is displayed in 
the action log window to indicate programmer operation. 
The execution on the [Blank Check] command before the [Erase] command is 
executed follows the setting of 'Command options' of the Advance tab displayed by 
selecting [Device] → [Setup]. 
Upon completion of [Erase] command execution, the GUI software displays the result 
of executing the command on the target device. 
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(3) [Program] command 
The [Program] command sends a specified user program to the target device and 
writes the program to the flash memory. 
The execution of Verify operation for detecting an error in user program 
communication from the FPL3 to the target device after the execution of the 
[Program] command follows the setting of the 'Command options' on the Advance tab 
displayed by selecting [Device] → [Setup]. 
During programming, the progress status is displayed in the action log window to 
indicate programmer operation.  This progress status display window displays the 
progress status on target device programming by percentage. 
Upon completion of [Program] command execution, the GUI software displays the 
result of executing the command on the target device. 

 
(4) [Verify] command 

The [Verify] command sends a specified user program to the target device connected 
with the FPL3, and performs verification against the data written to the flash memory 
of the target device. 
During verification, the progress status is displayed in the action log window to 
indicate programmer operation. This progress status display window displays the 
progress status of target device verification by percentage. 
Upon completion of [Verify] command execution, the GUI software displays the result 
of executing the command on the target device. 

 
(5) [Security] command 

  The [Security] command initiates the programming of the security flag of the target device 
connected to the FPL3. Set ‘Security flag settings’ on the Advance tab of the [Device] > 
[Setup…] menu. 

 
(6) [Checksum] command 
 The [Checksum] command reads the checksum value of the target device connected with 

the FPL3. 
 This value differs from the value displayed in the parameter window of the main window. 

 
(7) [Autoprocedure(EPV)] command 

The [Autoprocedure(EPV)] command executes the [Erase] command, [Program] 
command and [Verify] command in succession. 
When a user program is to be resent to the target device for comparison with the data 
written to the flash memory of the target device because of a user program 
communication error, execute the [Program] command by selecting [Device] → 
[Setup] and specifying 'Command options' on the Advance tab, then set the automatic 
execution of the [Verify] command. 
During EPV execution, the progress status is displayed in the action log window to 
indicate programmer operation.  For a selected command, its execution operation, 
and messages, refer to CHAPTER 9 HOW TO USE FPL3. 
Upon completion of [Autoprocedure(EPV)] command execution, the GUI software 
displays the result of executing the command on the target device. 

 
(8) [Signature read] command 
 The [Signature read] command reads the signature information (device name, flash 

memory information, and so forth) of the target. 
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(9) [Setup] command 

The [Setup] menu allows you to make settings related to flash memory rewriting 
according to the user environment and to set command options.  Each time the GUI 
software is started, the most recently used parameter file (.PRM) is read and the 
settings are displayed.  The [Setup] menu allows you to modify the settings of items 
other than those items consisting of shadowed characters according to the user 
environment. 

 
(a) Standard setup 

This menu is used to set the environment for rewriting the flash memory of the target 
device. 
The mode of communication with the target, the operating clock, and so forth differ 
depending on the device used.  For details, refer to the manual of the device used, 
when making settings. 
The window shown below is opened. 

 

Figure 44: Device Setup Window - Standard 

 
 

This window shows all basic options that can be set in accordance with the user 
environment and target device. 

 
[  OK  button] 
Clicking the  OK  button saves the settings on the Standard and Advance menus and 
closes the window. 

 
[  Cancel  button] 
Clicking the  Cancel  button closes the window without saving the settings on the 
Standard and Advance menus. 
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<1> Parameter file 
This file holds parameters and timing data required to rewrite the flash memory of 
the target device.  Do not modify the data in the parameter file because the data is 
related to the guarantee of rewrite data. 
The parameter file is protected by the checksum function.  If the checksum result 
indicates an error, the FPL3 does not accept the parameter file. 

 
 

Figure 45: Device Setup Window - Parameter File Selection 

 
 
 

 

Figure 46: Parameter File Selection Window 

 
 

[  PRM File Read  button] 
A window for specifying a parameter file is displayed.  Specify a desired file then 
click Open. 
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<2> Host connection 
"Host connection" is used to select a channel for communication between the L_Line  
– See it!-2 board and host machine. 

 

Figure 47: Device Setup Window – Host connection 

 
 

[Port list box] 
Select a channel for communication between the L_Line – See it!-2 board and host 
machine. 

•  COM1 to COM256 
 

Remark Selectable ports can be checked using Device Manager.  For details, 
refer to CHAPTER 7.6 Confirmation of USB Driver Installation. 

 
[Speed list box] 
Select a communication rate for the selected communication channel from the 
following: 

•  9600 bps  
•  19200 bps  
•  38400 bps 
•  115200 bps  

 
Remark For selectable communication rates, refer to the user's manual of the 

device used. 
 

<3> Supply oscillator 
"Supply oscillator" is used to select a clock that determines programming, data 
transfer, and a transfer rate. 

 

Figure 48: Device Setup Window - Supply Oscillator Selection 

 
 

[Frequency box] 
Sets the clock frequency of the target system. 
The range of operating frequency varies from one device to another.  So, check the 
specifications of the device used before making a setting. 
 
[Multiply rate] 
Specifies the division rate or multiplication rate of the target device. 
If the target device has an on-chip PLL circuit, enter a division rate or multiplication 
rate according to the use environment. 
The selectable division rate or multiplication rate differs depending on the device.  
Check the specifications of the device used before making a setting. 
If the target device does not have an on-chip PLL circuit, select "1.0". 
On the initial screen, the default setting is displayed according to the parameter file. 
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<4> Operation Mode 
The setting of "Operation Mode" may divide the flash memory of some target 
devices into blocks or areas. 
This menu is used to select an operation mode of the flash memory.  Some devices 
do not have the block and area division modes, and some devices have only one of 
the modes.  In these cases, a nonexisting mode is unchoosable. 

 

Figure 49: Device Setup Window - Operation Mode 

 
 

[When Chip is selected] 
The entire flash memory area of the target device is subject to rewrite processing. 
 
[When Block is selected] 
Specify the Block number range subject to rewrite processing by using Start/End. 
The Start/End list boxes display the Block numbers where the flash memory of the 
target device is configured. 

 
[When Area is selected] 
Specify the Area number range subject to rewrite processing by using Start/End. 
The Start/End list boxes display the Area numbers where the flash memory of the 
target device is configured. 
 
[Show Address check box] 
Specify whether numbers or addresses are displayed in the Start/End list boxes. 
If this check box is checked, addresses are displayed. 
If this check box is not checked, numbers are displayed. 

 
<5> Target Reset Message 

By checking the Target Reset Message check box, the window promoting the 
reset operation manually is displayed even when the reset signal cannot be 
connected to the target cable. 

 
 

Figure 50: Device Setup Window – Target Reset Message 
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(b) Advance setup 
The Advance setup menu is used to specify the command options and security flag 
settings. 
When "Advance" is clicked, the following window is displayed: 

 

Figure 51: Device Setup Window - Advance 

 
 

<1> Command options 
This dialog box is used to specify the FPL3 flash processing command options. 

 

Figure 52: Device Setup Window - Command options 

 
 

[Blank check before Erase check box] 
If this check box is checked, blank check is made before the Erase command or 
EPV command is executed. 
If the result of a blank check indicates OK, erase processing is not executed. 

 
[Read verify after Program check box] 
If this check box is checked, write data is sent from the programmer after execution 
of the Program command and EPV command, then the data is verified against the 
data written to the flash memory. 

 
[Security flag after Program check box]  
If this check box is checked, automatic programming of the selected security flag is 
executed after execution of the [Program] and [Autoprocedure (EPV)] commands. 
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[Checksum after Program check box] 
If this check box is checked, the flash memory checksum value of the target device 
is read from the target device after execution of the Program command and EPV 
command. 
This value differs from the value displayed in the parameter window of the main 
window. 

 
<2> Security flag settings 

The <Security flag settings> dialog box is used to specify which security function is 
valid. 

 
 

Figure 53: Device Setup Window – Security flag settings 

 
 

Caution: The following is the correspondence between the [Erase] and 
[Program] Commands when the security functions of a 78K0/LG2 
microcontroller are valid! 

 
 

 Chip Erase Command Block Erase Command Program Command 
Disable Chip Erase Invalid Invalid Valid (Note1) 
Disable Block Erase Valid Invalid Valid 
Disable Program Valid Invalid Invalid 
Disable Boot block 
cluster 
reprogramming 

Invalid Valid (Note2) Valid (Note2) 

 
Notes 1: Since the [Erase] command is invalid, the data that differs from the 

  data already written in the flash memory cannot be written. 
 

Notes 2: Valid only for the area other than the area specified as the boot area 
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[Disable Chip Erase check box] 
If this check box is checked, the [Erase] command becomes invalid in the entire flash 
memory area of the target device. 
At this time, the warning message shown below is displayed. 
 

Figure 54: Device Setup Window – Disable Chip Erase 

 
 
Caution: Be aware that if the security flag is set in the target device, neither erasing 

      nor writing to the device can be enabled afterward!!! 
 
[Disable Block Erase check box] 
If this check box is checked, the [Erase] command becomes invalid in all the blocks of the 
flash memory selected under Operation Mode in the Standard Setup menu. This setting is 
cleared by the [Erase] command when Chip was selected under Operation Mode. 
 
[Disable Program check box] 
If this check box is checked, the [Program] command becomes invalid, as does the 

[Erase] 
command in all the blocks of the flash memory selected under Operation Mode in the  
Standard Setup menu. 
The [Erase] command for the entire flash memory area is valid. This setting is cleared by 
the [Erase] command when Chip was selected under the Operation Mode. 
 
[Disable Boot block cluster reprogramming check box] 
If this check box is checked, the boot area is set with the boot block set in the Boot block 
Cluster setting as the last block. At this time, the warning message shown below is 
displayed. 
 

Figure 55: Device Setup Window – Disable Boot Cluster Reprogramming warning 

 
 
 
 
 
 
 
 

 
 

Caution: Be aware that if the security flag is set in the target device, the boot area 
      cannot be rewritten to the device afterward!!! 
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8.4.3 [View] menu 

Clicking the [View] menu displays the pull-down menu shown below. 
This menu contains commands for setting whether to display the toolbar and status bar. 

 

Figure 56: [View] Menu 

 
 
 

(1) [Toolbar] command 
 Checking the [Toolbar] command displays the toolbar. Unchecking the command hides the 

toolbar. 
 

 
(2) [Status Bar] command 
 Checking the [Status Bar] command displays the status bar. Unchecking the command 

hides the status bar. 
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8.4.4 [Help] menu 

Clicking the [Help] menu displays the following pull-down menu: 
 

Figure 57: [Help] Menu 

 
 
 

(1) [About FPL3] command 
 The [About FPL3] command opens the program entry window as shown below and 

indicates the version. 
 Clicking  OK  terminates the display. 

 

Figure 58: About FPL3 Window 
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8.5 Programmer Parameter Window 
 

This window displays the settings of the programming parameters. 
 

Figure 59: Programmer Parameter Window 

 
 

[Device] 
Updated after communication with the target device to display information about the target 
device. 

 
[Parameter file] 
Updated after [Setup] command execution to display information about a read parameter file. 

 
[Load file] 
Updated after [Load] command execution to select information about a selected program file. 
 
[Connection to device] 
Updated after [Setup] command execution to display information about the connection with the 
target device. 
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9. How to use FPL3 FLASH programming software 
 

This chapter explains the basic operation of the FPL3 GUI for programming the L_Line - See it! board. 
This chapter covers how to start the system, execute the EPV command, and program the target 
device. On the following pages the FLASH programming of the 78K0/LG2 via FPL3 is shown. 
 
The conditions of the series of operations described in this chapter are as follows: 
 
Hardware configuration of L_Line - See it!: 
 
Base board :  L_Line - See it! 
Target device :  78K0/LG2 (µPD78F0397D) 
Clock :  6 MHz 
Voltage level :  5 V 
 
Software configuration of FPL3: 
 
Parameter file: 78F0397D.PRM 
Clock setting :  6 MHz Multiplied by 1 
Port :  COM3 (115200 bps) 
Operation mode: Chip 
Write HEX :  78K0_LCD_DEMO.hex  
Option setting :  Blank check before Erase 

 

(1) Installing the FPL3 GUI software 
Install the FPL3 GUI software on the host machine you are using, by referring to CHAPTER 7 
SOFTWARE INSTALLATION (if the software has not been installed yet). 

 

(2) Installing the driver 
Install the USB driver on the host machine you are using, by referring to CHAPTER 7 
SOFTWARE INSTALLATION (if the driver has not been installed yet). 

 

(3) Installing the parameter file 
The parameter file for the 78K0/KG2 device are installed automatically during installation of FPL3 
GUI, folder <FPL3 install-path>\PRM. Nevertheless, newest version of parameter file for the 
µPD78F0397D device can by download from the NEC Electronics Web site. 
 
Download the parameter file for the PG-FP4 from the following NEC Electronics Web site: 
 

http://www.eu.necel.com/updates 
 
Copy the parameter file downloaded from the NEC Electronics Web site into sub-directory 
<FPL3.EXE-install-path>\PRM created during GUI software setup (refer to CHAPTER 7 
SOFTWARE INSTALLATION).. 
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(4) Connecting and starting 
 
<1> Set the L_Line - See it! board to the FLASH programming mode by switching SW1/S1 to 

ON: 
 

 
 

SW1 Setting Mode 
S1 ON Programming  mode 
S2 OFF UART6 select 
S3 OFF OCD disabled 
S4 OFF On-Board debug function 

Jumper Setting Mode 
JP1 1-2 Closed Power supply via USB 
JP2 Open Power supply via USB 
JP3 Closed Clock supplied via CPLD 

 
 
 
<2> <Plug and Play> Connect the L_Line - See it! board with the host machine via the USB 

cable. If the connection was already done, press the reset button SW2 to release the FLASH 
programming mode. 

 

 

SW1 

JP1 

JP2 

JP3 
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<3> Start the FPL3 GUI. 

 

Figure 60: GUI Software Startup Screen 

 
 

(5) Setting the programming environment 
<1> Select [Device] → [Setup] from the menu bar. 
<2> The Standard dialog box for device setup is activated. 
 

Figure 61: <Standard Device Setup> Dialog Box 
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<3> Click PRM File Read to open the parameter file selection window. 
 Select the parameter file “78F0397D.prm” then click Open. 
 

Figure 62: Parameter File Selection 

 
 

 
<4> From the Port list box, select the communication port that matches the host machine being 

used. Select the communication speed of the Host connection. 
 

Figure 63: Port Selection 

 
 

 
Remark Selectable ports can be checked using Device Manager.  For details, refer to 7.6 

Confirmation of USB Driver Installation. 
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<5> Set "Supply oscillator" according to the specifications of the L_Line - See it! board,  

“Frequency = 6.00 MHz” and “Multiply rate = 1.00”. In "Operation Mode", please 
specify the “Chip” mode. The following figure shows the recommended settings: 

 

Figure 64: <Standard Device Setup> Dialog Box after Setting 

 
 
 

<6> Switch to the Advance dialog box. 
 

Figure 65: <Advance Device Setup> Dialog Box  

 
 

 
 <Command options>  

Blank check before Erase :  Checked 
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<7> Click the OK button.  The GUI software sets the parameters. 
 When the settings have been completed, the following screen is displayed: 

 

Figure 66: Completion of Parameter Setting 

 
 

(6) Selecting a user program 
<1> Select [File] → [Load]. 
<2> Select a program file to be written to the target device, then click Open. 
 

Figure 67: After Downloading 

 
 
 

The display is updated. 

"Success read HEX file." is 
displayed. 

"PRM File Read OK." is displayed. 

The display is updated. 
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(7) [Autoprocedure(EPV)] command execution 
Select [Device] → [Autoprocedure(EPV)] from the menu bar. 
When the [Autoprocedure(EPV)] command is executed, Blank Check → Erase → Program and 
FLASH Internal Verify are executed sequentially for the µPD78F0397D device. 

 

Figure 68: After EPV Execution 

 
 
  

(8) Terminating the GUI 
Select [File] → [Quit] to terminate the GUI software. All settings executed so far are saved in the 
FPL3.INI file, so that those settings can be reused when the GUI software is restarted. 

 

(9) Execute “78K0_LCD_DEMO” application 
Set the L_Line - See it! board to the normal operation mode by switching SW1/S1 to OFF. 
< Plug and Play> the L_Line - See it! board to start in normal operation mode or press the reset 
button SW2 to release the normal operation mode. 

 

(10) Restarting the GUI 
When the system is restarted, the same screen as shown in Figure 58 appears. 

 

"...finish" is displayed. 
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10. TROUBLESHOOTING 
 

In driver installation, recognition based on Plug and Play is disabled. 
 

Cause: 
The USB connector may not be inserted normally into the USB port of the personal computer. 
Action: 
Check that the USB connector is inserted fully into the USB port of the personal computer. 
Alternatively, disconnect the USB connector, then insert the USB connector again after a while. 
 
 
The driver file cannot be found at a specified location. 

 
Cause: 
The FPL3 FLASH programming software may not be installed correctly. 
Action: 
Install the GUI software again by referring to CHAPTER 7 Software Installation. 

 
 

In checking by Device Manager, "USB Serial Port" or "USB High Speed Serial 
Converter" is not displayed.  Alternatively, the "!" or "×" is prefixed. 

 
Cause: 
The USB connector may not be inserted normally into the USB port of the personal computer. 
Action: 
Check that the USB connector is inserted fully into the USB port of the personal computer. 
Alternatively, disconnect the USB connector from the USB port, then insert the USB connector 
again after a while. 

 
Cause: 
The driver may not be installed correctly. 
Action: 
<1> When this product is connected to the personal computer, right-click the driver marked 

with "!" or "×". 
 Click Erase when displayed. 
<2> On Device Manager, execute [Hardware Modification Scan]. 
<3> Install the driver again with Plug and Play. 

 
Cause: 
The device may not be recognized (in the case of connection with the USB hub). 
Action: 
Try the following: 

•   Disconnect the USB connector, then insert the USB connector again. 
•   Connect the USB connector to another port of the USB hub. 

If the same symptom occurs, do not use the USB hub, but directly connect the connector to 
the USB port of the personal computer. 

 
 

When this product is connected with a personal computer, the "Add New Hardware 
Wizard" screen is displayed. 

 
Cause: 
If the USB connector of this product is not inserted into the USB port used at the installation 
time but into another USB port, this product may be recognized as a new hardware item. 
Action: 
Install the driver by referring to CHAPTER 7.5 USB Driver Installation. 
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Communication with the L_Line - See it! board is disabled. 

 
Cause: 
The driver may not be installed correctly. 
Action: 
Check if "USB Serial Port" and "USB High Speed Serial Converter" are installed correctly by 
referring to CHAPTER 7.5 USB Driver Installation. 

 
Cause: 
The COM port selected via the “Port list box” within device setup menu of FPL3 may not be 
set correctly. 
Action: 
Set the port checked using Device Manager. 

 
Cause: 
The L_Line - See it! board is operating in normal mode. 
Action: 
Set the board to the FLASH programming mode by setting SW1 switch S1 to ON. 
 

 
Cause: 
The PRM file selected in [Device Setup] may be incorrect. 
Action: 
Use the corresponding PRM file that matches the target device. For information about the 
PRM file, refer to CHAPTER 8 FPL3 FLASH programming software. 

 
Cause: 
The setting of "Supply oscillator" in [Device Setup] may be incorrect. 
Action: 
Make a correct setting according to the specifications of the target device. 
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11.  IAR configuration for On-Board debugging 
 

11.1 Setup COM port for IAR C-SPY debugger 
Before using the On-Board debug function of the L_Line – See it! board together with the IAR C-SPY 
debugger it is necessary to set the corresponding USB serial COM port of the host computer. Just be sure 
that you have installed the USB driver first. 
 
To set the COM port, please execute the registry script file “FTDI_Set_Registry.reg”. The script file can be 
found in the typical installation path of the IAR Embedded Workbench: 
 
“C:\Program Files\IAR System\Embedded Workbench 4.0\78k\config\nec” 
 
This script file will set the COM port number in the following registry key: 
 
[HKEY_LOCAL_MACHINE\SOFTWARE\NEC Tools\NECDEV\78K0.EX] 
 

 
Figure 69: Registry entry for IAR C-SPY debugger COM port setting 

 
Per default the serial port COM3 is set in the script file. If the L_Line – See it! board is used on a different 
USB serial COM port, please edit the script file accordingly. To do so, open the script file with your preferred 
editor i.e. “NOTEPAD” and make changes as described in the file. Then run the script file. 
 

11.2 Configuration of USB serial COM port 

To optimize the communication between the IAR C-SPY debugger and the L_Line – See it! board the USB 
serial COM port must be configured. To do so, open the “Device Manager”, which can be found in properties 
of “My Computer”. Then locate the USB serial COM port and select “Properties”, as show in figure below: 
 

                   Figure 70: Configuration of COM port for IAR C-SPY debugger 1/4 

 

 

Locate the "USB Serial Port 
(COM?)" and select properties. 
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The following USB Serial Port Properties Window appears: 
 

 
Figure 71: Configuration of COM port for IAR C-SPY debugger 2/4 

 
Then select the “Port Settings” tab of the USB Serial Port Properties Window and press the “Advanced” 
button: 
 

 
Figure 72: Configuration of COM port for IAR C-SPY debugger 3/4 

 
 

 

 

Press the “Advanced” 
button. 
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Within the “Advanced Settings” menu change the “Latency Timer (msec)” to a value between 2 and 4. For 
faster host computers set the “Latency Timer” to value 1. 
 
 

 
Figure 73: Configuration of COM port for IAR C-SPY debugger 4/4 

 
Press the OK button to save the configuration and close the properties menu. The configuration of the USB 
serial COM port is finished now and the IAR C-SPY debugger can now be used in combination with the On-
Board debug function of the L_Line – See it! board. 
 
 

 

Change Latency Timer value. 
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12. IAR sample session 
When everything is set up correctly the IAR Embedded Workbench can be started. To do so, start the 
Embedded Workbench from Windows “Start” menu > “Programs” > folder “IAR Systems” > “IAR Embedded 
Workbench Kickstart for 78K”. The following screen appears: 
 

 
Figure 74: IAR Embedded Workbench 

 
Now select the option “Open exiting workspace” from the “File” menu and locate the sample project. Open 
the file “78K0_LCD_demo.eww”. This is the workspace file that contains general information about the demo 
project and settings. 
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After the demo workspace has been opened the files contained in the workspace are displayed. Now click 
on the little “+” sign next to the filename “main.c” to show files that were referred in the source file. The 
screen should now look similar to this: 
 

 
Figure 75: IAR project workspace 

 
As a next step check some settings of the IAR Embedded Workbench that have to be made for correct 
operation and usage of the On-Board debug function of the L_Line – See it! board. First highlight the 
uppermost folder called “78K0_LCD_demo – Debug” in the workspace window. Then select “Project” > 
“Options” from the pull-down menus. Next select the category “Debugger”. Make sure that the driver is set 
to “TK-78” in order to use the On-Board debug function of the L_Line – See it! board. The device description 
file must be set to “io78f0397.ddf”. 
 

 
Figure 76: IAR debugger options 

 

 

Select “TK-78” to 
use On-Board 
debugging. 

Choose device 
description file of 
µPD78F0937. 
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Next the correct linker settings of the demo project will be checked. This can be done in the “Linker” 
category as shown below. Select the “Config” tab and check that the linker command file “DF0397_V4.XCL” 
is selected. This file is used by the linker and contains information on where to place the different sections 
of code and data that may be used within the demo project: 
 

 
Figure 77: IAR Linker options 

 
Now after everything has been setup correctly it’s time to compile and link the demonstration project. Close 
the Options menu and select “Rebuild All” from the “Project” menu. If the project is compiled and linked 
without errors or warnings it can now be downloaded to the L_Line – See it! board and debugged. To start 

the IAR C-SPY debugger select the option “Debug” from the “Project” menu or press the ( ) “Debugger” 
button. In the next step the TK-78 Emulator has to be configured before downloading a new application. 
Press the OK button to enter the emulator hardware setup. Set the configuration as show in the figure below 
and start the download by pressing the OK button. 
 

 
              Figure 78: TK-78 hardware setup menu 
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Now the debugger is started and the demo project is downloaded to the L_Line – See it! board. The 
progress of downloading is indicated by blue dots in the TK-78 Emulator window. Please note, downloading 
of greater executables can take some time. 
 

 
         Figure 79: IAR project download 
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After the download was completed all debug features of IAR C-SPY debugger are available, i.e. Single 
Stepping, Step Over/-In/-Out, Go-Execution, Breakpoints, Register / Memory view etc. 
 
To get more details on the debugger configuration and capabilities please refer to the “78K IAR Embedded 
Workbench IDE User Guide” of the IAR installation. 
 

 
Figure 80: IAR C-SPY debugger 
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13. Sample Project 
The sample program “78K0_LCD_DEMO” is located in a single directory, which will be called main-directory 
This main directory contains the complete project inclusive all output files of the IAR development tool. The 
directory structure is shown in the table below. 
 
 

 Debug Debug output files 

  Exe  executable output file for debugging, i.e. UBROF file 

  List  project list files 

  Obj  project object files 

 inc C header files 

 Release Release output files 

  Exe  output file for FLASH programming, i.e. Intel HEX file 

  List  project list files 

  Obj  project object files 

 settings configuration files, IAR Embedded Workbench 

 source C source files 

 xcl xcl file, linker command file 

 78K0_LCD_demo.eww workspace file, IAR Embedded Workbench 78K0/78K0S 

 78K0_LCD_demo.dep dependency information file, IAR Embedded Workbench 

 78K0_LCD_demo.ewd 
project setting file, IAR C-SPY debugger 

 78K0_LCD_demo.ewp 
project file, IAR Embedded Workbench 

Table 20: Sample project directory structure 

 
The main directory contains only the workspace and project files for the IAR Systems Embedded 
Workbench. All source files are located in the directory /source and the /inc directory contains the 
header files. The /xcl directory contains the linker command file of the 78K0/LG2 device. The sample 
project uses two targets for the microcontroller. One target is the IAR C-SPY debugger / simulator directory 
/Debug and the other is the L_Line – See it! hardware directory /Release including the programmable 
output file (Intel HEX file). 
 
All output files of the IAR Embedded Workbench are generated in these directories. For details of using the 
IAR Embedded Workbench and the IAR C-SPY debugger / simulator please refer to the corresponding IAR 
manuals. 
 
The L_Line – See it! sample project covers all functionalities of the starterkit hardware. All peripherals are 
used to demonstrate the capabilities of the 78K0/LG2 microcontroller. The sample project contains four 
main functionalities: 
 

•  Real-Time-Clock function 
•  Temperature measurement 
•  Light incidence measurement 
•  BUZZER output example 
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13.1 Real-Time-Clock function 

This part of the sample project realizes a Real-Time Clock. After the program is started the watch timer is 
initialized to generate an exact clock reference, based on the 32.768 kHz sub-clock. The actual time is 
displayed on the LCD panel. By using the navigation switch SW3 the time can be adjusted. Additionally two 
clock display modes can be chosen, the 24 hour mode or the AM/PM mode. 
 
 

13.2 Temperature measurement 

The temperature measurement is done by using the dual slope method. By using the dual slope method the 
resistor value of the temperature sensor is converted into a digital counter value. To do this, the charging 
time of capacitor C18 is measured with the 16-Bit Timer/Event Counter 00 of the microcontroller. The first 
charging slope uses a reference resistor (RREF = R6) and the second charging slope uses a variable resistor 
(RVAR= R5 + RT) which should be determined. By the comparison of the two measured times and the known 
reference resistor RREF the variable resistor of the temperature sensor can be calculated and consequently 
the temperature. The temperature is displayed on the LCD panel. Two display formats are supported, 
degree celsius and degree fahrenheit. The selection is done by using the navigator switch SW3. Additionally 
the temperature is transferred via UART6 to a terminal program running on the host machine. The data 
transfer speed is set to 115200 bps per default  
 
 

13.3 Light incidence measurement 
This part of the sample project does a light incidence measurement. The AD converter - channel 0 - of the 
78K0/LG2 microcontroller is used to do a cyclic measurement of the voltage at the phototransistor. The 
result of the measurement is converted into a per cent value and displayed on the LCD panel.  
 
 

13.4 BUZZER output example 
This demonstration drives the buzzer by using the 16-Bit Timer/Event Counter 01. The timer is configured to 
generate a rectangle wave-form. By changing the output frequency of the timer, different tones can be 
generated by the buzzer. As demonstration a simple melody is played. 
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13.5 Menu control 

To shift between the different operation modes of the sample project a menu system is implemented. 
The menu system is shown in the figure below: 
 

 
Figure 81: Menu control 

 
The first column shows the main menus and the second the sub menus. Switching between the main menus 
can be done by moving the navigation switch SW3 in the UP / DOWN direction. A sub menu can be entered 
by moving SW3 to the RIGHT. It can be left again by moving SW3 to the LEFT. 
 
The adjustment of the clock can be done in “SET” sub menu. The hour or minute value can be chosen by 
moving SW3 to the LEFT / RIGHT. The adjustment is done by moving SW3 UP / DOWN. The menu can be 
left by pressing SW3. 
 
The clock mode can be selected in the “MODE” sub menu. Move SW3 to the UP / DOWN direction to 
chose between the 24 hour mode or the AM/PM mode. The menu can be left by moving SW3 to the LEFT. 
 
By using the temperature measurement - menu “TEMP” - the different display modes - degree celsius or 
degree fahrenheit - can be selected by moving SW3 to the UP / DOWN direction. 
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14. Cables 
 

14.1 USB interface cable (Mini-B type) 
 

 
Figure 82: USB interface cable (Mini-B type) 
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15. Schematics 

 
Figure 83: L_Line - See it! schematics 1/3
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Figure 84: L_Line - See it! schematics 2/3
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Figure 85: L_Line - See it! schematics 3/3 


